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EditPad 7 Help 

Welcome to the documentation for EditPad Lite 7 and EditPad Pro 7. All features that are available in 
EditPad Lite are also available in EditPad Pro. Some features are available in EditPad Pro but not in EditPad 
Lite. Those features are indicated as (available in EditPad Pro only) in this help file. 

If you are upgrading from EditPad Pro 6 to EditPad Pro 7, check out whatõs new and learn how to migrate 
from EditPad Pro 6 to EditPad Pro 7. 

EditPad is very configurable. Almost every aspect can be adjusted to your own tastes and habits. Many 
settings can be made separately for each file type. To do so, select Options|Configure File Types in the 
menu. To edit general preferences, use Options|Preferences. 

You can access all of EditPadõs functionality through the main menu. Once you get used to working with 
EditPad, youõll mostly rely on the fully configurable toolbar and keyboard shortcuts. 

EditPadõs menus are: 

¶ File  

¶ Edit  

¶ Project  

¶ Search  

¶ Go  

¶ Block  

¶ Mark  

¶ Fold  

¶ Tools  

¶ Macros  

¶ Extra  

¶ Convert  

¶ Options  

¶ View  

¶ Help  

Some functionality can be accessed through panels that dock to the sides of EditPadõs window: 

¶ Search and Replace  

¶ Spell Check  

¶ Clip Collection  

¶ Character Map  

¶ Byte Value Editor  

¶ Files Panel  

¶ Explorer Panel  

¶ FTP Panel  

¶ File History  

¶ File Navigator  
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1. File Menu 

File|New  

Creates a new tab with a blank, untitled file. If you click the File|New item directly, then the file type for the 
new file is the one for which you selected òdefault file type for new filesó in the file type configuration. If you 
select a file type from the File|New submenu, then the new file uses the settings for the file type that you 
selected. 

If you use File|Save As and give the file a name with an extension that belongs to a file type other than the 
one used by File|New, then the fileõs file type is be changed to the file type associated with that extension. 
The file will then also use the settings defined for that file type. 

File|Open  

The File|Open command shows an open file common dialog. It allows you to open one or more files from 
the folder of your choice. To select more than one file, hold down the Shift or Control key on the keyboard 
while you click with the mouse. You can configure the initial folder of the open dialog in the Open Files 
Preferences. 

You can tick the read-only checkbox to force EditPad to open the file in read-only mode, regardless of 
whether the file is writable or not. This can be useful to make sure you donõt accidentally overwrite the file. It 
also tells EditPad not to try to open the file for writing. 

If the active file is untitled and empty, it is replaced by the file you open. This ensures EditPad does not get 
cluttered with empty tabs. 

If you open a single file that is already open, EditPad simply switches to the copy that is already open, as if 
you had clicked on its tab rather than attempting to open it again. If that file is open in another project, 
EditPad switches that project and to the file. If you open multiple files that are all open in the same project, 
EditPad switches to that project and to one of the files you wanted to open. 

If you open multiple files and some but not all of them are open in projects other than the active one, 
EditPad moves all the files into the active project. If some of the files were open in unmanaged projects, 
those files are removed from those projects. If some of the files were open in managed projects, those files 
are closed in those projects, but remain part of the other projects. 

If the active project is a managed, the File|Open command does not add the files to the project. The files 
show up under the projectõs tab as outside files. To make the files part of a managed project, either use 
Project|Add to Project instead of File|Open, or use Project|Add Outside Files after using File|Open. 
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Recently Closed Files 

The File|Open command has a submenu that lists recently closed files. Opening a file removes it from the 
File|Open submenu. Closing a file adds it to the top of the File|Open submenu. Selecting the file in that 
submenu opens it again. 

Only files that were opened individually are added to the menu when they are closed. That includes files 
opened by double-clicking on them in Windows Explorer or by dragging and dropping them onto EditPad. 
Files that are opened in bulk such as by opening a project or opening a folder are not added to the File|Open 
menu when you close them. The Project|Open Project and Project|Open Folder commands have their own 
submenus for reopening projects and folders. Whether you close files one by one or all at the same time does 
not matter. How the file was opened determines whether it is added to the File|Open submenu. 

At the bottom of the submenu, you will see the òRemove Obsolete Filesó and òRemove All Filesó items. The 
former removes all files that no longer exist from the list of recently closed files. The latter clears the list of 
recently closed files entirely. 

Though the menu can display only 16 files, EditPad Pro actually remembers the last 100 files. To access the 
complete list, select the Maintain Reopen List item at the bottom. This item is only available in EditPad Pro. 

When working with projects in EditPad Pro, the Project|Add to Project has its own submenu with recently 
closed files. It works just like the File|Open submenu, except that it remembers the last 100 files that were 
closed in that project only. If you havenõt worked with a project for a while, the Project|Add to Project 
submenu may still list closed files that have already dropped off the File|Open submenu. 

Maintain Reopen List 

Though the File|Open submenu can display only 16 files, EditPad Pro actually remembers the last 100 files 
you closed. To access the complete list, select the Maintain Reopen List item at the bottom. This item is only 
available in EditPad Pro. 
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To open many files again at once, select all of them and click the Open button. You can also select them in 
bunches and click the Open button several times. 

To remove files from the history, select them and click the Remove button. This will only remove files from 
the list. It will not delete any files. If you want to delete all files that no longer exist, you can do so by selecting 
òRemove Obsolete Filesó in the Reopen menu itself, rather than selecting òMaintain Listó to open the above 
screen. 

Using the Up and Down buttons, you can change the order of the files in the history list. Press the Control 
key on the keyboard while clicking the Up or Down button to move a file all the way to the top or the 
bottom. Only the first 16 items will be visible directly in the Reopen menu. 

Read-Only Files 

If a file is in use by an application, another application cannot modify it. Files stored on read-only media such 
as CD-ROMs cannot be modified by applications either. Files that have the read-only attribute set should not 
be modified by applications, but can be if you have the necessary security privileges to remove the read-only 
attribute. 

If you use EditPad to open a file that is already in use by another application, stored on read-only media, or 
has the read-only attribute set, EditPad will open that file in òread onlyó mode. This is indicated on the status 
bar. Where you normally see if the current file has been modified or not (the indicator shows òModifiedó or 
shows nothing), you will then see òRead Onlyó. A file that is in read only mode cannot be edited in EditPad. 
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You can turn off òread onlyó mode by clicking on the òRead Onlyó indicator on the status bar. If the file is in 
use by another application or stored on a read-only device, however, you still wonõt be able to save it even if 
you can edit it in EditPad. To save your changes, either close the other application that is using the file and 
then use File|Save, or save your changes to a new file with File|Save As. If the file was opened as read-only 
because the read-only attribute was set, EditPad will attempt to remove the read-only attribute if you try to 
save the file. 

The File|Open screen has a òread onlyó checkbox at the bottom. If you tick that, EditPad opens the file as 
read only, even if the file is perfectly writable. In that case, clicking the òRead Onlyó indicator on the status 
bar makes the file editable, as if you had opened it without using the òread onlyó checkbox. 

If you have a file open that is not read only and it doesnõt have any unsaved changes, you can make it read-
only by clicking the blank space in the status bar reserved for the òModifiedó or òRead Onlyó indicator. This 
only prevents accidental changes to the file in EditPad. EditPad does not set the fileõs read-only attribute, nor 
does it prevent other applications from modifying the file. 

File|Favorites 

In the Favorites submenu of the File menu, you can keep lists of files that you often work with. This way you 
can quickly open them to continue working on them. 

To add a file to your favorites list, first open the file in EditPad. Then select File|Favorites|Add Current File 
from the menu. The next time you open the File|Favorites menu, you will see the file listed there. The files 
are sorted alphabetically by their complete path names. If you have added folders via the Organize Favorites 
screen (see below), you can add a file to one of the folders by selecting the òAdd Current Fileó item from the 
folderõs menu. 

To purge files that no longer exist from the list of favorites, select òRemove Obsolete Filesó from the 
Favorites menu. If you have created folders, non-existent files will be purged from those folders as well. To 
remove only certain files, whether they still exist or not, use the Organize Favorites screen. 

To open one of your favorite files, simply choose it from the Favorites menu. To open many of your favorite 
files, use Organize Favorites. 

Organize Favorites 

Click the File|Favorites item directly or select Organize Favorites from the File|Favorites submenu to 
organize the list of your favorite files, or to open many of those files quickly. 
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To open one or more files, select them and click on the Open button. Note that when selecting more than 
one file, all the files must be in the same folder. You cannot select multiple files across folders. If you want to 
open files from several folders, open them folder by folder. You can click the Open button as many times as 
you want to open as many files as you want. 

To remove one or more files from the favorites, select them and click on the Remove button. This will not 
delete the files, but only remove them from the list of favorites. If you want to remove all files that no longer 
exist, select Remove Obsolete Files instead of Organize Favorites from the File|Favorites menu. 

To add files to the favorites, first select the folder to which you want to add them. If you select a file, the files 
will be added to the folder which contains the selected file. Then click the Add Files button and choose one 
or more files. If you want to add files without putting them inside a folder, click on a file in the favorites that 
is not inside a folder either. Then click the Add Files button. 

Use the New Folder button to create a new folder to which you can add favorites. You can change the 
caption of a folder by clicking on the folder and then clicking on the Rename Folder button. Creating folders 
is useful if you have more than twenty favorite files. If you add more than 20 files directly to the favorites 
menu, or to one of the folders, then the menu listing your favorites will become very long and difficult to use. 
Note that creating a folder here to hold your favorites does not actually create a folder on your hard disk. It 
simply adds a hierarchical structure to the list of favorites stored in your EditPad Pro preferences. 

You can move files between folders by dragging and dropping them with the mouse. EditPad Pro 
automatically sorts the list of favorites alphabetically. You cannot rearrange files inside a folder. 

File|Templates  

The Templates submenu of the File Menu works just like the Favorites submenu, with one small but 
important difference. When you select a file from the Favorites menu, EditPad simply opens that file. If you 
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select a file from the Templates menu, however, EditPad will create a new, untitled file with the content of 
the file you selected. 

If you often edit a particular file, saving the changes back into the same file, you should add it to the 
Favorites. If you often create new files based on the contents of a particular file, you should add that file to 
the Templates menu. Using templates, you wonõt accidentally save the changes over the original file. 

The Favorites and Templates menus are completely independent. You can add the same file to both. 

File|Save 

Saves the active file to disk, overwriting the original, if any, without warning. 

In Save Files Preferences you can specify if and how backup copies should be created. 

If the active file is untitled, File|Save invokes File|Save As. 

File|Save As 

Saves the active file under a new name. If the active file has previously been saved, the original copy will 
remain available. If you later use File|Save after using File|Save As, it will save under the new name as well. 
This is indicated by the file name on the tab which changes after you use File|Save As. 

When you select File|Save As, a save file common dialog box will appear. You can select the folder in which 
you want to save and type in a file name. You can configure the initial folder of the save dialog in the Open 
Files Preferences. 

If you do not specify an extension for the file name, EditPad adds one depending on the selection you made 
in the filters (the bottommost drop-down list) in the Save As dialog box. If the active filter is òany fileó (*.*), 
no extension is added. If any other filter is active, the default extension for that file type will be added to the 
file name. The default extension is the first extension listed in the Extensions setting of the file typeõs settings. 

If you do specify an extension, EditPad will save the file with that extension. If the extension is part of 
another file type, all the file type dependent settings such as auto indent, number lines and word wrap will be 
changed to match the settings for that new file type as made in the file type configuration. 

File|Save All 

Rapidly performs a File|Save for each open file, in each project. 

For untitled files, File|Save As is invoked. If you click on Cancel in the save as dialog box, the save all 
function will not save any further files either. 
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File|Print  

Select File|Print in the menu to print the active file. A preview of the printout is shown first. 

 

The margins can be changed by moving the mouse over one of the dotted blue margin lines. The mouse 
pointer will change to indicate that you can move the margin, and a hint box will indicate the size of the 
margin in centimeters and inches. Click on the line, hold the mouse button down and drag the line until it 
indicates the desired margin position. 

With the blue arrow buttons at the top, you can browse through the pages that will be printed. You can also 
press the Page Up and Page Down keys on the keyboard. 

The magnifying glass buttons zoom the preview in and out. You can also press the plus and minus keys on 
the numeric keypad on your keyboard. Zooming does not affect the printout, only the preview. 

If you want to print with a different font or different text spacing, click the Font & Layout button. This 
button shows the same text layout configuration screen as the Options|Text Layout menu item, except that it 
shows the text layouts you have configured for printing rather than the ones youõve configured for editing. 
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Another difference is that if you turn on the òallow bitmapped fontsó checkbox, the font list will include 
printer fonts rather than screen fonts in addition to the TrueType and OpenType fonts that work everywhere. 
A òprinter fontó is a font built into your printerõs hardware. If you select a printer font, set òtext layout and 
directionó to òleft to right onlyó for best results. 

Because EditPad keeps separate text layout configurations for printing and editing, any changes you make to 
text layouts via the print preview only affect the printout. EditPad remembers the layout you used for 
printing in combination with the layout you used for editing. If you edit a file with a text layout youõve called 
òedit monospacedó and you print it with a text layout youõve called òprint monospacedó, then the next time 
you print a file youõre editing with the òedit monospacedó layout, the print preview will automatically select 
the òprint monospacedó layout. 

Press the Setup button to access your printerõs setup screen or to select a different printer than the default 
printer. 

òFrom pageó and òto pageó determine the range of pages that will be printed. The value of òfrom pageó must 
be smaller than or equal to that of òto pageó, even if you want to print in reversed order (see below). 
òCopiesó is the number of copies that should be printed of each page. 

Activating òAll pagesó will print all pages in the range specified by òfrom pageó and òto pageó, while òodd 
pagesó will print only the odd-numbered (1, 3, 5, ...) pages in the range, and òeven pagesó only the even-
numbered (2, 4, 6, ...) ones. If the page range is only one page (òfrom pageó equals òto pageó) and that page is 
odd-numbered while òeven pagesó is activated, or the other way around, nothing will happen when you click 
the Print button. You will not get an error message. 

If you mark òReversedó, the pages will be printed from last to first instead of from first to last. This can be 
useful if you have an inkjet printer that puts pages in reversed order in the out tray. 

If you opened the print preview with File|Print, you can mark the òselection onlyó box to print only those 
lines that are selected in EditPad. The òselection onlyó checkbox works at the level of a single line. If a line is 
partially selected, it will be printed. If you only want to print exactly what you selected, select Block|Print in 
the menu instead. 

If you have a monochrome printer or you do not want to waste expensive color ink cartridges, turn off òprint 
in coloró to print black text without any background colors. If you turn on òprint in colorsó, the printout is in 
full color. Be careful if you have selected the white on black color palette. Youõll see white on black in the 
print preview, and the printout will use loads of black ink to make the whole page black. 

When printing only the selection, syntax coloring may be applied differently when you use Block|Print to 
print the exact selection rather than using File|Print and turning on òselection onlyó to print the selected 
lines. With Block|Print, the syntax coloring will color the block as it were the whole file, while File|Print 
applies syntax coloring to the whole file, even with òselection onlyó turned on. 

Turn òprint line numbersó on or off to print the file with or without line numbers, regardless of whether 
youõve used Options|Line Numbers to edit the file with line numbers. The print preview remembers this 
checkbox separately for each file type. 

In EditPad Pro, you can use the òvisualize spacesó and òvisualize line breaksó checkboxes to make spaces and 
line breaks visible in the printout or not, overriding the Options|Visualize Spaces and Options|Visualize 
Line Breaks menu items. These checkboxes are also remembered separately for each file type. 
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If you used the Fold|Fold command to hide certain lines, then you can turn on the òhide folded linesó option 
to exclude those lines from the printout. The printout will not indicate folding ranges with òplusó or òminusó 
buttons. 

If you have òprint in coloró turned on, you can click the Color Palette button to select a different set of 
colors. You should select a palette that uses a white background. Otherwise, EditPad will use loads of ink to 
give the printout a colored background. If you print on colored paper, you should still select a white 
background in EditPad. EditPad cannot determine the color of your paper. White is assumed. The Color 
Palette button shows the same color selection screen as the corresponding button in the file type 
configuration. If you edit any palettes, those changes also affect the palettes used for editing. If you want to 
use different palettes for editing and for printing, create new palettes for printing instead of editing existing 
ones. EditPad remembers the palette used for printing in combination with the palette used for editing. E.g. if 
you edit a file with the òBorland classicó palette (which uses a blue background) and then select the 
òEmbarcaderoó palette for printing it without the blue background, then the print preview automatically 
defaults to the Embarcadero palette next time you print a file that youõre editing with the Borland palette. 

Click the òPrintó button to start printing. Then click the òCloseó button or press Escape on the keyboard to 
close the print preview. 

Print Headers 

Click the "Headers & Footers" button in the Print Preview window to change the headers and footers to be 
printed, if any. 

The headers and footers are printed inside the margins specified on the print preview. If no headers or 
footers are specified, their space will be claimed by the text body. 

A few special placeholders are available in the headers and footers: 

%P   Page number of the current page 
%N   Total number of pages 
%D   Current date, printed using the short date format specified in the regional settings of the Control Panel 
%T   Current time, printed using the short time format specified in the regional settings of the Control Panel 
%FD  Date the file was last modified, again printed in short date format. 
%FT  Time of the day the file was last modified, again printed in short time format. 
%FP  Full path to the file being printed: folder + filename 
%FN  Filename (without folder name) of the file being printed 

File|Mail  

Select File|Mail from the menu to send the current file to somebody via email. The email composition pane 
is shown. 
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Type in your full name followed by your own email address in the field labeled òFromó. If you have 
previously used the email function, you can quickly select your email address from the drop-down list. 

Then type in the recipientõs email address in the òToó field. You can either enter the recipientõs full name 
followed by his or her email address, or you can enter only the email address. 

If you want to send your message to more than one recipient, click the Add button next to the òToó field to 
add the first email address to the list. Then type in the second email address into the òToó field, and click the 
Add button again. Do so for all recipients. If you make a mistake, you can remove a recipient by selecting his 
or her email address from the list and clicking the Remove button. 

In the òSubjectó field, type in the subject of the email message. 

If you want to attach files to the email message, click the Attach button. Select the file you want to send. You 
can attach more than one file if you want to. If you change your mind about attaching a file, click on it in the 
list and click the Remove button below the list of attachments. 

The Send or Enqueue button does not become enabled until you type in your email address, the recipientõs 
email address, and the messageõs subject. When you click the Send button, the email is placed in the mail 
queue and sent out immediately. When you the Enqueue button, the email will be added to the mail queue, 
but will not be sent until you click the Send button in the mail queue. Which of the two buttons appears 
depends on the option to send out email immediately in the Email Preferences. 

Before you can actually send mail, you need to specify the outgoing mail server that EditPad Pro should use 
in the Email Preferences. If you havenõt done this yet, clicking the Send button brings up the Preferences 
screen. 

Mail Queue 

The mail queue pane appears after you click the Enqueue or Send button in the mail composition pane. Each 
time you click the Enqueue or Send button, another email message will be added to the bottom of the mail 
queue. The messages will be marked as òqueuedó. 
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Click the Send button in the mail queue to start sending the messages in the queue. EditPad Pro will start 
sending the first message in the queue marked as òqueuedó. EditPad Pro always starts sending the first 
message, no matter which message you selected in the queue before clicking the Send button. When the first 
message has been sent, EditPad Pro continues with the next, until all queued messages have been sent. The 
message that is being sent is marked as òsendingó. After it has been sent, it will either be marked as òsentó in 
case of success, or òfailedó in case the message could not be sent. While email is being sent, EditPad Pro tells 
you what is happening in the caption bar above the queue. The caption indicates òEmail Queueó if you have 
not sent anything yet. 

To remove a message from the queue, select it and click the Delete button. You can delete any message, even 
while EditPad Pro is sending email . Only the message that is currently being sent (if any) cannot be deleted 
from the queue. If you want to delete all successfully sent messages from the queue, click the Close button. 

If EditPad Pro could not send a particular message, it will be marked as òfailedó. If you want to try the 
message again without making any changes to it, select it and click the Retry button. This will mark the 
message as òqueuedó. You can do this whether EditPad Pro is sending messages or not. Alternatively, you 
can cancel sending the message by deleting it from the queue. EditPad Pro will not automatically retry failed 
messages. You have to mark them again as òqueuedó. 

To move a message up or down in the queue, select it and click the Move Up or Move Down button. You 
can move any message, regardless of its status. However, the order of the messages only matters for those 
marked as òqueuedó. The first one in the list is the one that will be sent next, regardless of which message is 
currently being sent (if any). 

Click the Close button to close the mail queue pane. This will also delete all successfully sent messages from 
the pane. The only way to make the mail queue appear again after closing it, is to add another message to the 
queue through the mail composition pane. Therefore, you cannot close the mail queue while email is being 
sent. If the pane takes up too much space, click on the minimize button on the caption bar below the queue. 
This will hide the list of messages and the buttons, but not the caption bar. This allows you to continue 
monitoring the progress in the caption bar, and to see the queue again by clicking the minimize button turned 
restore button again. 

Note that the email queue sends email in the background. This means that you can continue using EditPad 
Pro as usual, including composing new emails, while email is being sent. This is particularly useful when 
sending large attachments over a slow connection. The only function you cannot use is File|Exit. 

File|Mail as Attachment 

Select òMail as Attachmentó from the File menu to start with a blank email message and attach the current 
file to the email. The mail composition pane will appear to allow you to further prepare the email message. 
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File|Reload from Disk  

Select File|Reload from Disk from the menu to revert the active file to the status it had when it was last 
saved. This can be useful if you are viewing a file that is being written to by another program. 

Note that if you switch tabs within EditPad or if you switch to another application and then back to EditPad, 
EditPad automatically checks whether the file on disk has been changed. If so, and you have not modified the 
file in EditPad, it will be automatically reloaded. If you did modify the file in EditPad, you will be asked if you 
want to keep the changes made in EditPad or reload from disk. In the Open Files Preferences, you can 
disable the automatic reload, or make EditPad always prompt before reloading. 

If  you click Keep Changes, EditPad will not reload the file, and will not overwrite the file on disk unless you 
use File|Save. If you want to keep both the changes youõve made in EditPad and the modified copy of the 
file on disk, click the Keep Changes button, and then use File|Save As to save the changes in EditPad into a 
new file. 

In addition, EditPad Pro gives you the option to see the difference between the file in EditPad and the file on 
disk. If you click the See Difference button, EditPad Pro invokes Extra|Compare with File on Disk. EditPad 
Pro will not reload the file, and will not ask you again to reload the file, until is is changed on disk again. If you 
want to reload the file from disk after looking at the differences, use the File|Reload from Disk menu item. 

File|Save Copy As 

The Save Copy As command in the File menu works just like File|Save As. The only difference is that after 
File|Save Copy As, the File|Save command will continue to save the file using the original file name. The file 
name indicated by the tab does not change. 

The Save Copy As command adds an extra òopen the saved fileó checkbox at the bottom of the file selection 
screen. If you turn on this option, EditPad opens the copy of the file that you just saved. Youõll end up with 
two tabs, one for the original file, and one for the copy. You can edit them independently. 

See File|Save As for more information on how EditPad saves files. 

File|Rename and Move 

Use this function to move the active file into a different folder, and/or to change its file name. 

This feature is similar to File|Save As, except that the original file will be deleted after the file has been saved 
under the new name, effectively òmovingó the file. 

File|Delete  

After you confirm the warning message, File|Delete closes the active file and also deletes it from disk. 
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If Windows keeps a Recycle Bin for the drive the active file is on, it will be moved into the Recycle Bin 
awaiting its final fate. 

File|Close 

Closes the active file. If the file has unsaved modifications, depending on the choice you made in Open Files 
Preferences, EditPad will ask if you want to save, automatically save or automatically discard the changes. If 
you closed the last file in the project, EditPad will automatically start with a new, blank file. 

You can also close the active file by clicking with the mouse wheel on the fileõs tab. If you have enabled the X 
button to be shown on tabs or the tab control in the Tabs Preferences, you can use the X button to close the 
file. Closing a file by closing its tab is exactly the same as using the File|Close menu item. 

If the file is part of a managed project, closing open files does not remove the file from the project. Files that 
are part of managed projects remain part of the project as closed files. The Files Panel and Search Panel can 
show and search through files that are closed but are still part of managed projects. Closing outside files 
removes them from the project, because they were never an actual part of the project. 

If you want to remove an open file from a managed project, use Project|Remove From Project to close and 
remove the file. If you want to remove files that you have already closed from a managed project, use 
Project|Remove Closed Files. 

To close EditPad itself, click on the X button in the upper right of the Window, or select File|Exit in the 
menu. 

File|Close All  

Select Close All in the File menu to close all open project and all open files. If any files have unsaved 
modifications, depending on the choice you made in Open Files Preferences, EditPad will ask if you want to 
save or not, automatically save or automatically discard the changes. 

EditPad will start with a new untitled project, with one blank untitled file. 

To close all files in the current project only, use Project|Close All Files, or close the project itself with 
Project|Close Project. To close EditPad itself, click on the X button in the upper right of the Window or 
select File|Exit in the menu. 

File|Close All but Current 

Closes all files in the current project, except the one youõre currently viewing. If any files have unsaved 
modifications, depending on the choice you made in Open Files Preferences, EditPad will ask if you want to 
save or not, automatically save or automatically discard the changes. 

To close all files in all projects, except the current file, use Project|Close All but Current to close all other 
projects, and then File|Close All but Current to close all other files. 
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File|Exit  

Closes all files and terminates EditPad completely. 

If you have enabled EditPadõs icon next to the system clock in the System Preferences then File|Exit is not 
the same as clicking the X button in the upper right corner. Clicking the X button keeps EditPad in memory 
and keeps the icon visible, enabling EditPad to pop up instantly next time you want to edit a file. File|Exit 
removes the icon and shuts down EditPad completely. 

If the icon next to the system clock is disabled, clicking the X button is the same as using File|Exit. 
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2. Edit Menu 

Edit|Undo  

Use Edit|Undo to undo the last editing action. Repeat to undo more actions. 

You can undo the undo with Edit|Redo if you do so right away. If you take any other action that is 
remembered by the undo function, the redo list will be cleared. Only trivial actions such as moving the cursor 
do not clear the redo list. 

You can undo several actions in one go via the submenu of the Undo command. When you select an action, 
that action and all actions listed above it in the submenu will be undone at once. They will all be added to the 
redo list too. 

If you use the menu item or toolbar button to invoke this command, it will be invoked on EditPadõs main 
editor, where you edit files. If you press the shortcut key on the keyboard, it will be invoked on whichever 
editor is showing the text cursor (vertical blinking bar), whether thatõs the main editor, the search box, or the 
replace box. 

The undo feature remembers all changes you made to any file since you opened it in EditPad. Saving a file 
does not clear the undo list. Switching between files switches between the undo lists of those files. EditPad 
remembers the changes you made to each file even while you work with other files, until you close each file. 

Undoing and redoing actions updates the fileõs òmodifiedó status as indicated by the status bar and tab color. 
When you undo all changes you made since last saving the file, or redo all changes you undid since last saving 
the file, the file will be indicates as being unmodified. 

EditPad may use quite a lot of memory to remember all the changes you made to all the files you have open. 
Some commands, such as a search-and-replace across all files, may result in very large numbers of changes. 
EditPadõs undo history includes a safeguard to make sure EditPad does not run out of memory. If the undo 
history grows too large, EditPad automatically discards the oldest changes. In extreme cases, like a search-
and-replace that makes millions of replacements, the undo history may be cleared entirely. 

In EditPad Lite, the memory limits are set automatically to make sure EditPad Lite doesnõt use up all of your 
computerõs memory, while still being able to keep a complete undo history. Unless youõre making millions of 
changes in a search-and-replace, EditPad Liteõs undo history can easily keep track of a full dayõs worth of text 
editing. 

In EditPad Pro, you can configure the limits in the System Preferences. The default limits use the same 
balance as EditPad Lite. The actual numbers depend on the amount of RAM your PC has. 

In practical terms, you neednõt worry about EditPadõs undo history. Itõll remember virtually everything, 
without causing your computer to run out of memory and crash. If you do need to undo very long editing 
sessions, EditPadõs backup options and File History may be more practical anyway. 
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Edit|Redo  

If you change your mind after undoing an action with Edit|Undo, use Edit|Redo to redo it. 

The redo function works exactly the same like the undo function, except that making any change to a file in 
any way except through Edit|Undo or Edit|Redo, will clear the redo list. 

In contrast with other text editors, EditPad Lite and Pro do not clear the redo list when you take a trivial 
action such as moving the text cursor or making a selection. This gives you more opportunity to change your 
mind and redo undone actions. 

If you use the menu item or toolbar button to invoke this command, it will be invoked on EditPadõs main 
editor, where you edit files. If you press the shortcut key on the keyboard, it will be invoked on whichever 
editor is showing the text cursor (vertical blinking bar), whether thatõs the main editor, the search box or the 
replace box. 

Edit|Cut  

Deletes the current selection and places it on the Windows clipboard. Use Edit|Copy to put the selection on 
the clipboard without deleting it. If there is no current selection, the entire current paragraph is deleted and 
placed onto the clipboard. 

Any data previously held by the clipboard is removed from it. Use Edit|Cut Append instead if you do not 
want this. 

EditPad always copies text to the clipboard using Windows line breaks. This ensures maximum compatibility 
with other Windows applications. If the file uses syntax coloring, then EditPad places both plain text and rich 
text on the clipboard. When you paste the rich text version into a word processor, it will be pasted with the 
same font and colors you were using in EditPad. The rich text version is only generated when another 
application requests it. When copying and pasting within EditPad or between EditPad and another plain text 
editor, no time or memory is wasted to generate the RTF. If you donõt want word processors to paste rich 
text, either use the òpaste as plain textó or òpaste unformatted textó command in your word processor, or tell 
EditPad Pro not to copy rich text in the Editor Preferences. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

If youõre editing a file in hexadecimal mode, and you cut something from that file, and you paste that into 
another application or into a file youõre editing in text mode in EditPad, the result will differ depending on 
whether the cursor was in the hexadecimal section or the ASCII section when you used Edit|Cut. If you cut 
from the hexadecimal section, and paste into another application, the other application will see the 
hexadecimal representation on the clipboard, e.g.: ò74657374ó. If you cut from the ASCII section, the other 
application will see the actual bytes, e.g.: òtestó. 

If you cut and paste between EditPad and another hex editing application, you may need to switch EditPad to 
hexadecimal mode and place the cursor in the hexadecimal or ASCII section of the editor to get the results 
you expect. 
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Edit|Cut Append  

Deletes the current selection and places it on the Windows clipboard. Use Edit|Copy Append to do this 
without deleting the selection from EditPad. If there is no current selection, the entire current paragraph is 
deleted and placed onto the clipboard. 

If the clipboard already holds plain text data, the selection is appended to the text already on the clipboard, 
even if the text was placed on the clipboard by another application. Edit|Paste will then paste both the 
original text plus the selection appended to it. 

If the file uses syntax coloring, and the clipboard already holds a rich text version of other text copied by 
EditPad, then the rich text version is appended to as well. If the clipboard holds rich text copied by another 
application, Edit|Cut Append removes it from the clipboard. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

Edit|Copy  

Places the current selection on the Windows clipboard. If there is no current selection, the entire current 
paragraph is placed onto the clipboard. 

Any data previously held by the clipboard is removed from it. Use Edit|Copy Append instead if you do not 
want this. 

If you select a block that includes one or more folded sections and copy the block to the clipboard, all 
selected lines, including lines hidden by folding, will be copied to the clipboard. Use Fold|Copy Visible Lines 
if you donõt want to copy the hidden lines. When pasting back into EditPad Pro, the folded sections remain 
folded. 

EditPad always copies text to the clipboard using Windows line breaks. This ensures maximum compatibility 
with other Windows applications. If the file uses syntax coloring, then EditPad places both plain text and rich 
text on the clipboard. When you paste the rich text version into a word processor, it will be pasted with the 
same font and colors you were using in EditPad. The rich text version is only generated when another 
application requests it. When copying and pasting within EditPad or between EditPad and another plain text 
editor, no time or memory is wasted to generate the RTF. If you donõt want word processors to paste rich 
text, either use the òpaste as plain textó or òpaste unformatted textó command in your word processor, or tell 
EditPad Pro not to copy rich text in the Editor Preferences. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

If youõre editing a file in hexadecimal mode, and you copy something from that file, and you paste that into 
another application or into a file youõre editing in text mode in EditPad, the result will differ depending on 
whether the cursor was in the hexadecimal section or the ASCII section when you used Edit|Copy. If you 
copy from the hexadecimal section, and paste into another application, the other application will see the 
hexadecimal representation on the clipboard, e.g.: ò74657374ó. If you copy from the ASCII section, the other 
application will see the actual bytes, e.g.: òtestó. 
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If you copy and paste between EditPad and another hex editing application, you may need to switch EditPad 
to hexadecimal mode and place the cursor in the hexadecimal or ASCII section of the editor to get the results 
you expect. 

Edit|Copy Append  

Places the current selection on the Windows clipboard. If there is no current selection, the entire current 
paragraph is placed onto the clipboard. 

If the clipboard holds text data, the selection is appended to the text already on the clipboard. Edit|Paste will 
then paste both the original text plus the selection appended to it. 

If the file uses syntax coloring, and the clipboard already holds a rich text version of other text copied by 
EditPad, then the rich text version is appended to as well. If the clipboard holds rich text copied by another 
application, Edit|Copy Append removes it from the clipboard. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

Edit|Paste  

If you select Edit|Paste when the Window clipboard holds textual data, it will be inserted into the active file 
at the current position of the text cursor. If EditPad is in overwrite mode, and youõre not pasting whole lines 
(see below), the pasted text overwrites the text after the cursor, as if you had typed in the text. Pressing the 
Insert key on the keyboard or clicking the Insert/Overwrite indicator on the status bar toggles between insert 
and overwrite modes. 

If the active file does not use Windows line breaks, the text on the clipboard is automatically converted to the 
correct line break style before it is inserted. The text on the clipboard remains untouched, in case you want to 
paste it into other applications too. 

If you want to paste a block of text from another application as a rectangular selection, first make a 
rectangular selection in EditPad, and then paste. EditPad will then interpret the text on the clipboard as a 
rectangular block and replace the selection with it. Text copied from EditPad Pro is always pasted in the way 
(linear or rectangular) you had it selected when you cut or copied it. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

In EditPad Pro, the option òpaste whole lines when lines are copied as a wholeó affects how text is pasted if 
you copied complete lines to the clipboard. Copying a complete line means to copy everything from the start 
of the line to the end of the line, including the line break at the end of the line. Copying multiple lines 
completely means copying everything from the start of the first line in the block until the end of the last line 
in the block, including the line break at the end of the last line. When the option òpaste whole lines when 
lines are copied as a wholeó is on, lines that were copied as a whole are always pasted as if the cursor were at 
the start of the line when youõre pasting. Thus, lines copied as a whole are always pasted as a whole before the 
line that the cursor is on when pasting. This makes it easy to move blocks of lines around without worrying 
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about the horizontal position of the text cursor. If this option is off, text is always pasted at the exact spot the 
text cursor is at, even when whole lines were copied. Only whole lines copied in EditPad can be pasted as 
whole lines. EditPad cannot determine whether text copied from other applications is a whole line or not. 
EditPad Lite does not have this option and always pastes at the exact spot the text cursor is at. 

In hexadecimal mode, if the clipboard contains a hexadecimal representation of characters, the effect of the 
Paste command depends on whether the text cursor is in the hexadecimal section at the left, or the ASCII 
section at the right. If you paste into the hexadecimal section, EditPad will paste the bytes represented by the 
text on the clipboard. If you paste into the ASCII section, EditPad will paste the text on the clipboard òas isó. 
E.g. if the clipboard holds ò74657374ó, pasting into the hex section inserts òtestó, while pasting into the 
ASCII section inserts ò74657374ó into the file. 

If the text on the clipboard is not text with hexadecimal values, EditPad pastes the text regardless of whether 
the cursor is in the text or hexadecimal section. If the clipboard holds something you copied in hexadecimal 
mode in EditPad, EditPad will always paste the bytes that you copied, even if you moved the cursor from the 
ASCII to hex section or vice versa. If you copied text from a file in EditPad that youõre editing in text mode, 
then the hex interpretation does take place. 

If you copy and paste between EditPad and another hex editing application, you may need to switch EditPad 
to hexadecimal mode and place the cursor in the hexadecimal or ASCII section of the editor to get the results 
you expect. 

Edit|Swap with Clipboard  

If you select Edit|Swap with Clipboard when the Window clipboard holds textual data, it will be swapped 
with the current selection in the active file. That is, the selection is put on the clipboard as happens when you 
use Edit|Cut and then the text previously held by the clipboard is pasted into the text like Edit|Paste does. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

Edit|Select All  

Selects all the text in the active editor. This command is always invoked on whichever editor is showing the 
text cursor (vertical blinking bar), regardless of whether you use the main menu, a toolbar button, or a 
keyboard shortcut. 

Edit|Insert Date & Time  

Inserts the current date and time at the position of the text cursor. If you click this item directly or use its 
keyboard shortcut, the date and/or time are inserted using the format you last used. If youõve never used this 
command before, it defaults to the short date and time formats set in the Windows Control panel. 

To use a different date and time format, or to insert the date only or the time only, select Other Date & Time 
format in the submenu of the Insert Date & Time menu item. A screen will pop up with a list of date and 
time specifiers. You can type in the date and/or time format that you want in the edit box at the top. You can 
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double-click a specifier in the list to add it to the format. The òactual date and timeó box shows a preview of 
the text that will be inserted when you click OK. 

The Insert Date & Time submenu keeps a history of the last 16 formats that you used. Click on one to insert 
the current date and/or time using that format. 

Date and Time Format Specifiers 

These are the date and time placeholders that you can use. Format specifiers may be written in upper case as 
well as in lower case letters. Both produce the same result. 

c           Displays the date in short format followed by the time in long format as specified in the 
regional settings in the Windows Control Panel. 
d           Displays the day as a number without a leading zero (1-31). 
dd          Displays the day as a number with a leading zero (01-31). 
ddd         Displays the day as an abbreviation (Sun-Sat) in the language of the current Windows locale. 
dddd        Displays the day as a full name (Sunday-Saturday) in the language of the current Windows 
locale. 
ddddd       Displays the date using the short date format specified in the regional settings in the Windows 
Control Panel. 
dddddd      Displays the date using the long date format specified in the regional settings in the Windows 
Control Panel. 
m           Displays the month as a number without a leading zero (1-12). If the m specifier immediately 
follows an h or hh specifier, the minute rather than the month is displayed. 
mm          Displays the month as a number with a leading zero (01-12). If the mm specifier immediately 
follows an h or hh specifier, the minute rather than the month is displayed. 
mmm         Displays the month as an abbreviation (Jan-Dec) in the language of the current Windows 
locale. 
mmmm        Displays the month as a full name (January-December) in the language of the current 
Windows locale. 
yy          Displays the year as a two-digit number (00-99). 
yyyy        Displays the year as a four-digit number (0000-9999). 
h           Displays the hour without a leading zero (0-23). 
hh          Displays the hour with a leading zero (00-23). 
n           Displays the minute without a leading zero (0-59). 
nn          Displays the minute with a leading zero (00-59). 
s           Displays the second without a leading zero (0-59). 
ss          Displays the second with a leading zero (00-59). 
z           Displays the millisecond without a leading zero (0-999). 
zzz         Displays the millisecond with a leading zero (000-999). 
t           Displays the time using the short time format specified in the regional settings in the Windows 
Control Panel. 
tt          Displays the time using the long time format specified in the regional settings in the Windows 
Control Panel. 
am/pm       Uses the 12-hour clock for the preceding h or hh specifier, and displays õamõ for any hour 
before noon, and õpmõ for any hour after noon. The am/pm specifier can use lower, upper, or mixed case, 
and the result is displayed accordingly. 
a/p         Uses the 12-hour clock for the preceding h or hh specifier, and displays õaõ for any hour before 
noon, and õpõ for any hour after noon. The a/p specifier can use lower, upper, or mixed case, and the result is 
displayed accordingly. 
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/           Displays the date separator character specified in the regional settings in the Windows Control 
Panel. 
:           Displays the time separator character specified in the regional settings in the Windows Control 
Panel. 
'xx'/"xx"   Characters enclosed in single or double quotes are displayed as-is, and do not affect 
formatting. 

Edit|Insert Matching Bracket  

The Insert Matching Bracket command is only available when bracket matching is enabled in the syntax 
coloring section of the file type configuration for the active fileõs file type. The syntax coloring scheme 
determines exactly which brackets are matched. See that section in this help file to learn how bracket 
matching works in EditPad Pro. 

Just like the syntax coloring scheme determines which brackets are matched, it also determines what is 
inserted by the Insert Matching Bracket command. When an unclosed opening bracket is highlighted, the 
corresponding closing bracket is inserted. When an unmatched closing bracket is highlighted, the 
corresponding opening bracket is inserted. The HTML and XML schemes insert matching opening and 
closing tags. 

The Insert Matching Bracket command is intended to be used while typing with minimal cursor movement. 
If you wanted to type "this <b>bold</b> word" into an HTML file, you would first type "this <b>bold", 
then use Edit|Insert Matching Bracket, and then type ò wordó. When you use Edit|Insert Matching Bracket, 
the cursor is automatically placed after the inserted tag. 

Do not use Insert Matching Bracket immediately after typing "this <b>". Though it may seem neat to close 
the bold tag immediately, before typing its contents, this requires unnecessary cursor movement. Youõd end 
up with the cursor after "this <b></b>ò requiring you to move the cursor back over the ó</b>" tag, then 
type òboldó, then move the cursor forward over "</b>ò and then type ó word". Since EditPad Pro 
automatically highlights the "<b>" tag as long as it is unclosed, there is no need to close it immediately. 
Simply leave it unclosed until you have typed in everything you want between the tag, and then use 
Edit|Insert Matching Bracket. 

If you use Insert Matching Bracket when an unmatched closing bracket is highlighted, it inserts the matching 
opening bracket. The cursor is then placed to the left of the bracket that was inserted. This way you can easily 
use Edit|Insert Matching Bracket repeatedly to insert multiple opening brackets. E.g. if you type 
"unclosed)}] " into a C++ file, then put the cursor before òunclosedó, and then use Edit|Insert Matching 
Bracket three times, youõll get "[{(unclosed)}] ". 

The Insert Matching Bracket command can match up an unmatched bracket even when matching brackets 
are highlighted. In the C statement if (a == b) && (c == d))  the last )  is unmatched. If you put the 
cursor before the first ( , EditPad Pro will highlight it as being matched with the )  after b. This clearly shows 
that the if  statement isnõt properly enclosed in parentheses. If you use Edit|Insert Matching Bracket with 
the cursor at this position, EditPad Pro looks for the nearest unmatched bracket. In this case that is the 
final )  in the statement. EditPad Pro inserts ( , correctly completing if ((a == b) && (c == d)) . 
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Edit|Duplicate Line  

Duplicates the line the text cursor is on. 

If you use the menu item or toolbar button to invoke this command, it will be invoked on EditPadõs main 
editor, where you edit files. If you press the shortcut key on the keyboard, it will be invoked on whichever 
editor is showing the text cursor (vertical blinking bar), whether thatõs the main editor, the search box or the 
replace box. 

Edit|Insert Page Break 

Select Insert Page Break from the Edit menu or press Ctrl+Enter to insert a page break into the current file at 
the current position of the text cursor. 

A page break will show up as a horizontal line while you edit the file in EditPad Pro. When you print the file, 
a new page will be started at the page break. The first paragraph below the horizontal line indicating the page 
break, will be the first paragraph on the new page. 

Edit|Delete  

Deletes the selected part of the current file. If nothing is selected, or when selections are persistent, the 
character to the right of the cursor is deleted. 

This command is always invoked on whichever editor is showing the text cursor (vertical blinking bar), 
regardless of whether you use the main menu, a toolbar button, or a keyboard shortcut. 

Edit|Delete Line  

Selects the line the text cursor is currently on, and deletes it. If the cursor is on the first line of a folded block 
of lines, indicated by a square with a + in it in the left margin, then all the lines folded underneath the current 
line are also deleted. 

If you use the menu item or toolbar button to invoke this command, it will be invoked on EditPadõs main 
editor, where you edit files. If you press the shortcut key on the keyboard, it will be invoked on whichever 
editor is showing the text cursor (vertical blinking bar), whether thatõs the main editor, the search box or the 
replace box. 
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3. Project Menu 

About EditPad Pro Projects 

An EditPad Pro Project is a series of files that you can open all at once through Project|Open Project. If you 
regularly work with a set of related files, it is convenient to create a project file for them. You could have a 
project for your web site, for the source code of an application you are working on, the chapters of your next 
book, etc. 

When you start EditPad Pro, it opens with an untitled project containing one untitled blank file. To create a 
project, simply open all the files that should be in the project. If you already have some files open that you 
donõt want to be in the new project, select Project|New Project in the menu before opening the files. After 
opening the files, save the project with Project|Save Project As. From that point on, EditPad Pro 
automatically maintains the project. Whenever you open new files into the project, or close files, the projectõs 
file list is updated. 

If you prefer to actively manage the list of files in the project, turn on the Managed Project option in the 
Project menu. Then you can use the commands below that item to add files to the project or remove them. 
You can still open and close files as usual using the File menu, but opened files wonõt be added to the project, 
and closed files wonõt be removed. 

Project files also keep track of the last editing position, bookmarks and editing options for each file in the 
project. When you reopen a project the next time you start EditPad Pro, it will be in exactly the same state as 
it was in when you last closed the project. EditPad Pro will not bother you with prompts to save the project. 

You can have as many projects open at the same time as you want. Creating a new project or opening an 
existing one does not close the files or projects that you already have open. By default, once you have two or 
more projects open, a second row of tabs will appear above the row of tabs for files. The new row of tabs 
allows you to switch between open projects. The tabs for files will list only those files that are part of the 
active project. Tabs can be configured in the Tabs Preferences. 

Project|New Project 

Select New Project in the Project menu to start with an untitled project containing a blank, untitled file. 

An untitled project is simply a holding space for files. When working with lots of files at the same time, itõs 
often handier to create a bunch of untitled, temporary projects to hold different sets of files. Instead of 
having one long row of tabs for all the files, youõll have one row of tabs for the projects, and one row of tabs 
showing only the files in the active project. Itõs often faster to switch between files by clicking on one project 
tab and on one file tab, than to scroll through a long list of file tabs. 

If you regularly work with the same set of files, save the project with Project|Save Project As. From that 
point on, EditPad Pro automatically maintains the project. Whenever you open new files into the project, or 
close files, the projectõs file list is updated. 

If you prefer to actively manage the list of files in the project, turn on the Managed Project option in the 
Project menu. Then you can use the commands below that item to add files to the project or remove them. 
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You can still open and close files as usual using the File menu, but opened files wonõt be added to the project, 
and closed files wonõt be removed. 

Project|Open Project 

Opens an EditPad Pro Project saved with Project|Save Project. Click the Project|Open Project item directly 
to show a file selection window from which to select the .epp  file. Or use the submenu of the Project|Open 
Project item to reopen a recently closed project. Opening a project removes it from the Project|Open 
submenu. Closing a project adds it to the top of the Project|Open submenu. You can manage the 
Project|Open Project submenu just like the File|Open submenu. 

You can have as many projects open at the same time as you want. Opening a project does not close any 
projects that are already open. If you opened individual files before opening the project, those files are in an 
untitled project that will remain open. If the active project is untitled and holds only a blank untitled file, then 
the blank project is closed when you open a project. 

Each file can be open only once in a single EditPad instance. If the project youõre opening holds a file that is 
already open in another project that is open in EditPad, the file is closed in the other project. If that project is 
unmanaged, that causes the file to be removed from the other project. If the other project is managed, the file 
is still closed in that project, but it remains part of it. The fileõs options, cursor position, and any unsaved 
changes are all preserved. The file is closed in the other project and moved òas isó to the newly opened 
project. 

Project|Favorite Projects  

The Project|Favorite Projects menu works just like the File|Favorites menu, except that it lists EditPad Pro 
project files rather than text files. You have to save a project before you can add it to the favorites. 

Project|Save Project As 

Select Save Project As from the Project menu to save the current project under a different name. From that 
point on, EditPad Pro will automatically maintain the project, updating the file you saved it into. Whenever 
you open new files into the project, or close files, the project is updated. If the project was previously saved 
under another name, the old project file will not be updated unless you reopen the old project. 

You only need to use Save Project As when you want to save an untitled project, or you want to create a new 
copy of a previously saved project. There is no need to repeatedly save projects under the same name to 
prevent losing changes like you would do with files. EditPad Pro always saves project files automatically when 
the state of the project changes as soon as youõve saved the project once to give it a file name. 

Project|Save All Files in Project 

Rapidly performs a File|Save for each open file in the current project. 
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For untitled files, File|Save As is invoked. If you click on Cancel in the save as dialog box, the save all 
function will not save any further files either. 

Project|Open Folder 

Select Open Folder from the Project menu to open all files or files of a certain type from a particular folder. 

 

You can type in the path to the folder containing the files you want to open into the drop-down list at the 
top. If you have recently opened files from this folder, you can select it from the drop-down list. EditPad Pro 
remembers the last 16 folders. Another way to select the folder is to browse for it using the folder tree. The 
drop-down list and folder tree are automatically kept in sync. 

Mark the option òrecurse through subfoldersó if you also want to open files contained in subfolders of the 
folder you selected. 

If you want to open all files in the folder (and optionally its subfolders), select the òall filesó option. If you 
want to open only files from a certain type, you can select òfiles of typeó and pick one of the file types from 
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the drop-down list. The list will contain all the file types you defined in Configure File Types. This will open 
all files that match the file typeõs file mask. 

To open files matching another list of extensions, select òfile maskó and type in the list of extensions or file 
masks, separated by semicolons, into the òfile maskó drop-down list. You can also select a recently used file 
mask from the drop-down list. 

If you choose the òregular expressionó option, then the regular expression must find a (partial) match in the 
name of a file for it to be included in the search. This regex is used to filter files by their names only. If you 
want to search through the contents of the files, use the Find on Disk command in the Search menu instead 
of the Open Folder command. 

Tick òcreate new projectó to open the files into a new, untitled project. This is the same as using Project|New 
Project before using Project|Open Folder. 

Tick òopen the filesó to make EditPad Pro actually open all of the files. If you turn this off, then òadd files to 
the projectó is automatically turned on, and EditPad Pro adds the files to the project without opening them. 
The files will show up in the Files Panel as closed files. Since only managed projects can contain closed files, 
turning off òopen the filesó automatically changes the current or the new project that the files are added into 
a managed project. 

Tick òadd the files to the projectó to add the files to the project. If you turn this off, then òopen the filesó is 
automatically turned on, and the files will be opened as outside files, without adding them to the project. 
Since only managed projects can have files open that arenõt part of the project, turning off òadd the files to 
the projectó automatically changes the current or the new project that the files are opened into a managed 
project. 

Recently Opened Folders 

The Open Folder item has a submenu that lists recently opened folders. Each time you use Project|Open 
Folder, the opened folder is added to top of this submenu. Though the menu shows only the folderõs path, all 
the settings from the Open Folder window are remembered by the menu. Select Maintain List in the 
submenu to see the settings used for each folder. When you select one of the remembered folders, EditPad 
Pro opens the files contained by that folder, using the same file mask and other options as you last used for 
that folder. If you have opened files from this folder more than once, the folder will appear only once in the 
Reopen Folder menu, with the most recently used settings. 

òRemove Obsolete Foldersó removes all folders that no longer exist from the Open Folders submenu. 
EditPad Pro does not check whether the folders still contain any files matching the file mask. EditPad Pro 
only checks whether the folders themselves still exist. òRemove All Foldersó clears the Open Folders 
submenu. 

Project|Managed Project 

New projects created with Project|New Project are always unmanaged projects. The blank project that 
EditPad Pro starts up with is also unmanaged. If you used EditPad Pro 6 in the past, projects in EditPad Pro 
6 were always unmanaged. 
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In EditPad Pro 7, an unmanaged project means that you wonõt be explicitly managing which files are part 
of the project and which arenõt. The project simply consists of the files that you have open in the project. 
Opening a file automatically adds it to the project, and closing a file automatically removes it from the project. 

Unmanaged projects are a great way to keep groups of files that you are working with, without requiring any 
extra effort from you. Simply save the project once to give it a file name. From then on, EditPad Pro 
automatically updates the project. The project will always open the set of files you had open in it last time. 

A managed project means that EditPad Pro expects you to manage which files are part of the project, and 
which arenõt. A managed project can contain three kinds of files: open files are part of the project and are in 
EditPad; closed files are part of the project, but are not open in EditPad; outside files are not part of the 
project, but are open under the projectõs tab in EditPad. If you close a managed project and then open it 
again, the òopen filesó are opened again, the òclosed filesó are not opened but remain part of the project, and 
the outside files are gone (they may still exist as separate files, but the project wonõt remember them). Open 
files and outside files have their own tabs under the projectõs tab. Closed files do not have tabs until you open 
them again. 

In the Files Panel, all files in unmanaged projects, and open files in managed projects are listed using a plain 
font. Outside files in managed projects are listed in italics. Closed files in managed projects are listed with a 
dimmed font. Closed files may not be listed at all if you turned off the option to show closed files in the Files 
Panel. Double-clicking a closed file opens it. 

Managed projects take a bit more effort. Itõs worth it for projects that consists of large sets of files because a 
managed project doesnõt force you to open all the files that it contains. You can quickly access closed files 
from the Files Panel and you can even search through closed files without opening them (as long as the 
project is open). Managed projects are also great for preventing accidental changes. Files are opened as 
outside files, and closing files doesnõt remove them. The list of files in the project remains the same, unless 
you explicitly add files to the project or remove files from the project. 

To turn an unmanaged project into a managed one, select the Managed Project item in the Project menu or 
click the corresponding toolbar button. The icon on the projectõs tab changes from the red unmanaged 
project icon to the blue managed project icon. All files that were open in the unmanaged project become part 
of the managed project as open files. 

You can turn a managed project back into an unmanaged one by selecting the Managed Project item in the 
Project menu again. If the managed project consisted of open files only, all that happens is that the icon on 
the projectõs tab changes from blue to red to indicate the project is unmanaged. If the managed project 
contained closed files and/or outside files, EditPad Pro will ask what you want to do with those files. 
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Unmanaged projects cannot contain closed files. If you try to turn a managed project that contains closed 
files into an unmanaged project, you need to choose what to do with the closed files. If you select to open 
them, the closed files will be opened and remain part of the unmanaged project as open files. If you select to 
remove them, the closed files are removed from the project. They will remain as individual files on your hard 
disk. 

Unmanaged projects cannot have outside files. If you try to turn a managed project that has outside files into 
an unmanaged project, you need to choose what to do with the outside files. If you select to keep them open, 
the outside files remain open and will be added to the unmanaged project as open files. If you select to close 
them, the outside files are closed and removed from the project. They will remain as individual files on your 
hard disk. 

The project menu offers several commands that you can use to handle open files, closed files, and outside 
files in managed projects: 

Add to Project: Select files from disk to be opened and added to the project as open files. 
Add to Project Unopened: Select files from disk to be added to the project as closed files. 
Add Active File: If the active file is an outside file, add it to the project as an open file. 
Add Outside Files: If the project has one or more outside files, add all of them to the project as open files. 
Open Closed Files: If the project contains one or more closed files, open them all. 
Remove From Project: Close the active file and remove it from the project. 
Remove Closed Files: If the project contains one or more closed files, remove them all from the project. 
Close Outside Files: If the project has one or more outside files, close them all and remove them from the 
project. 
Close All Files: Close all files in the project. If the project has outside files, those are removed from the 
project. Open files remain part of the project as closed files.  

Project|Add to Project 

The Add to Project command in the Project menu works like the File|Open command with two small but 
important differences. 
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If the active project is a managed project, files opened with Project|Add to Project are opened and added to 
the project as open files. Files opened with File|Open are opened as outside files that are not part of the 
project. If you close the managed project and then reopen it, files opened with Project|Add to Project are 
opened again along with the project, while files opened with File|Open are not remembered by the project. 

If you have already opened files with File|Open and they now appear as outside files in your managed 
project, you can use Project|Add Outside Files to make them part of the project. 

If the active project is an unmanaged project, then there is no difference between opening files using 
File|Open or Project|Add to Project. Both commands add the files and open files to unmanaged projects. 

The other difference is the submenu with recently closed files. This applies to both managed and unmanaged 
projects. The File|Open submenu lists files that were opened and then closed in any project, including 
untitled projects that were never saved. This list is saved by EditPad along with its general settings and history 
information. The Project|Add to Project submenu lists files that were opened and then closed in the current 
project only. This list is saved in the .epp  project file. 

If you havenõt worked with a particular project for a while, any files that you had open in that project and 
then closed will have long dropped off the 100 files that the File|Open submenu remembers. But when you 
open that project again, the Project|Add to Project submenu will still remember the last 100 files you closed 
while working with that project. 

The File|Open and Project|Add to Project submenus remember all files that were closed even if you didnõt 
use that menu item to open them. For example, if you double-click on a file in Windows Explorer and then 
close the file, it will be listed at the top in both File|Open and Project|Add to Project. If you then switch to 
another project, the file will still be at the top in File|Open but wonõt be in the Project|Add to Project 
submenu for the project you switched to. Files that are opened in bulk such as by using Project|Open Folder 
are not remembered by either menu. 

Project|Add to Project Unopened 

The Add to Project Unopened command in the Project menu shows a file selection window just like 
File|Open and Project|Add to Project. Unlike these two commands, Add to Project Unopened does not 
open any files. The selected files are added to the project as closed files. 

Only managed projects can contain closed files. If the active project is unmanaged, using the Add to Project 
Unopened command automatically turns the project into a managed one, as if you had selected 
Project|Managed Project in the menu. 

Project|Add Active File 

The Add Active File command in the Project menu is only available if the active project is managed and the 
active file is an outside file. An òoutside fileó is a file that is open under the projectõs tab, but is not actually 
part of the project. When a project is closed and reopened, outside files are not remembered. Use the Add 
Active File command to make the file a part of the project, so it will be remembered by the project. 
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If the active project has many outside files, you can use Project|Add Outside Files instead if you want to 
make them all part of the project. 

Project|Add Outside Files 

The Add Outside Files command in the Project menu is only available if the active project is managed and it 
has one or more outside files. An òoutside fileó is a file that is open under the projectõs tab, but is not actually 
part of the project. When a project is closed and reopened, outside files are not remembered. Use the Add 
Outside Files command to make all such files part of the project, so they will be remembered by the project. 

If you want to add some of the outside files but not all of them, use the Project|Add Active File to add them 
one by one. 

Project|Open Closed Files 

The Open Closed Files command in the Project menu is only available if the active project is managed and it 
has one or more closed files. A òclosed fileó in a managed project is a file that was closed but is still part of 
the project. The Open Closed Files command opens all such files in the active project. 

If you want to open some but not all closed files in a managed project, use the Files Panel. If you want to 
search through all files in a managed project, there is no need to open closed files. Simply turn on the Closed 
Files search option to search through all files that are part of the project, whether they are open or closed. 

The Open Closed Files command is not available for unmanaged projects, because closing a file in an 
unmanaged project automatically removes it from the project. For managed projects, the Open Closed Files 
command does not reopen files that were removed from managed projects with Project|Remove From 
Project and does not reopen outside files that were not part of the project when they were closed. Such files 
may still be listed in the Project|Add to Project submenu. You can use that submenu to reopen them. 

Project|Remove from Project 

The Remove from Project command in the Project menu closes the active file and removes it from the 
project. For unmanaged projects, there is no difference between Project|Remove from Project and 
File|Close. For managed projects, files closed with Project|Remove from Project are completely removed 
from the project, while files closed with File|Close remain part of the project if they were added to the 
project. 

If you want to remove a file that is already closed from a managed project, use the Files Panel. If you want to 
remove all closed files from a managed project, use Project|Remove Closed Files. If you want to remove all 
outside files from a project, use Project|Close Outside Files. 

Files that are removed from a project are added to the File|Open and Project|Add to Project submenus that 
list recently closed files, unless the files were opened in bulk withProject|Open Folder or a similar command. 
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Project|Remove Closed Files 

The Open Closed Files command in the Project menu is only available if the active project is managed and it 
has one or more closed files. A òclosed fileó in a managed project is a file that was closed but is still part of 
the project. The Remove Closed Files command removes all such files from the the active project. 

If you want to remove only some closed files from the project, use the Files Panel. 

Files that are removed from a project are added to the File|Open and Project|Add to Project submenus that 
list recently closed files, unless the files were opened in bulk withProject|Open Folder or a similar command. 

Project|Close Outside Files 

The Close Outside Files command in the Project menu is only available if the active project is managed and it 
has one or more outside files. An òoutside fileó is a file that is open under the projectõs tab, but is not actually 
part of the project. When a project is closed and reopened, outside files are not remembered. Use the Close 
Outside Files to remove all such files from the project immediately. 

Files that are removed from a project are added to the File|Open and Project|Add to Project submenus that 
list recently closed files, unless the files were opened in bulk withProject|Open Folder or a similar command. 

Project|Close All Files 

Use the Close All command in the Project menu to close all files in the active project. The result is the same 
as if you had used File|Close for each file in the project. The project itself remains open. 

If the project is unmanaged, the files are removed from the project. 

If the project is managed, files that are part of managed projects remain part of the project as closed files. The 
Files Panel and Search Panel can show and search through files that are closed but are still part of managed 
projects. Any outside files that were open under the projectõs tab are removed from the project, because they 
were never an actual part of the project. 

Project|Reload Files from Disk 

Select Reload Files from Disk from the Project menu to revert all open files in the active project to the status 
they had when they were last saved. This can be useful if you are viewing files that are being written to other 
programs. 

If one or more of the files in the project have unsaved changes in EditPad Pro, or if you turned on the option 
to always prompt in the Open Files Preferences, then EditPad Pro will ask you to confirm which files you 
want to reload. Files that have unsaved changes in EditPad Pro will be marked as òModifiedó in the list. 
Those changes will be lost if you reload those files. Tick the checkbox next to each file that you want to 
reload. 
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Project|Save Copy of Project As 

Select Save Copy of Project As to save the project under a new name, but continue updating the project 
under its original name. Use this command if you want to save a milestone copy of the project that you can 
go back to later. EditPad Pro will not keep the copy of the project updated along with the original. The new 
copy will stay as it is, until you open it or overwrite it when saving another project. By opening the copy of 
the project, you can go back to the project in the state it was in when you saved the copy. 

Project|Rename and Move Project 

Select Rename/Move Project in the Project menu to save the project under a new name, and delete the 
original project, effectively moving the project to a new location on disk. 

Project|Import File Listing  

Select Import File Listing in the Project menu to read a list of files from a text files, and then open those files. 

 

In the window that appears, click the button with the green plus symbol next to the òfiles with file listingsó 
list to select one or more text files that list the files or folders you want to search through. You can use the 
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green plus button repeatedly to add files from different folders to the list. The red X button deletes the 
selected file from the list. 

Click on one of the files that you added to the òfiles with file listingsó list. EditPad Pro then shows the raw 
contents of that file in the òcontents of the selected fileó box. EditPad Pro also shows the file and folder 
paths that has detected in that file in the òfile paths found in the selected fileó list. The settings on the right 
hand side of the Import File Listings screen determine how EditPad Pro detects those paths. EditPad Pro 
automatically filters out anything that does not look like a valid path. 

Choose one of the options in the òsplit file into a list of file pathsó box to tell EditPad Pro how your list of 
paths is delimited. If your list doesnõt use a consistent delimiter, select òsearch for pathsó to tell EditPad Pro 
to extract all absolute paths from the file, regardless of any other text that may occur in the file. If you want 
EditPad Pro to extract only certain paths from the file, select one of the two òcustom regexó options and type 
in a regular expression in the box below them. The òcustom regex to search for pathsó option needs a regular 
expression that matches the paths you want to mark in the file selection. EditPad Pro uses the whole regex 
match as the path unless it contains a named capturing group called òpathó. E.g. ç^File=(?'path'.*) » 
extracts the paths from òFileó values in an .ini file. The òcustom regex to split fileó option needs a regular 
expression that matches the delimiters between those paths. E.g. «[ \ r \ n;]+ » allows line breaks and 
semicolons as delimiters. 

If you select òabsolute pathsó, EditPad Pro only uses fully qualified paths such as c: \ folder \ file.txt  
and \ \ server \ share \ folder \ file.txt . Any relative paths in the file listing youõre importing are 
ignored. If you want EditPad Pro to process relative paths as well then you need to select the òpaths relative 
to this folder optionó. Type in the base folder below that option, or click the (...) button to select it from a 
folder tree. Note that if your file contains text in addition to paths, you need to use one of the òcustom 
regexó options to tell EditPad Pro how to find only the actual paths. Otherwise, EditPad Pro will treat each 
word in the text as a file name. You cannot use the òsearch for pathsó option because that option finds 
absolute paths only, regardless of the òabsolute or relative pathsó setting. 

Once youõve set the options that make EditPad Pro find the paths that you want to import, you need to tell 
EditPad Pro what you want to do with the files those paths point to. Tick òcreate new projectó to open the 
files into a new, untitled project. This is the same as using Project|New Project before using Project|Import 
File Listings. 

Tick òopen the filesó to make EditPad Pro actually open all of the files. If you turn this off, then òadd files to 
the projectó is automatically turned on, and EditPad Pro adds the files to the project without opening them. 
The files will show up in the Files Panel as closed files. Since only managed projects can contain closed files, 
turning off òopen the filesó automatically changes the current or the new project that the files are added into 
a managed project. 

Tick òadd the files to the projectó to add the files to the project. If you turn this off, then òopen the filesó is 
automatically turned on, and the files will be opened as outside files, without adding them to the project. 
Since only managed projects can have files open that arenõt part of the project, turning off òadd the files to 
the projectó automatically changes the current or the new project that the files are opened into a managed 
project. 
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Recently Imported File Listings 

The Import File Listings item has a submenu that lists recently imported file listings. Each time you use 
Project|Imported File Listing, the files you imported are added to top of this submenu. If you imported a 
single file, the submenu lists the full path to the file. If you imported multiple files at once, the submenu has 
one item with a comma-delimited list listing all the file names that fit within the maximum length for a menu 
item. The submenu item remembers all the settings you made in the Import File Listings window. When you 
select one of the remembered file listings from the submenu, it is imported again using the exact same 
settings. 

òRemove Obsoleteó removes all files that no longer exist from the Import File Listings submenu. This 
removes all file listings that try to import from a file that no longer exists. If a file listing imports from files 
that still exist, but no paths can be found in those files, then the file listing is removed as well. 

Project|Export File Listing  

Select Export File Listing to save a text file that lists the full paths to all the files in the active project. The 
paths are delimited by line breaks. If the project is managed then open files, closed files, and outside files are 
all added to the exported file listing. 

Project|Delete Project 

Select Delete Project in the Project menu to close the active project and delete the .epp  file that you saved 
with Project|Save Project As. Only the .epp  project file is deleted. The files that were open in the project are 
not deleted. 

Project|Close Project 

Closes the current project and all the files in the project. If any files in the project have unsaved 
modifications, depending on the choice you made in Open Files Preferences, EditPad will ask if you want to 
save or not, automatically save, or automatically discard the changes. When you close the last project, EditPad 
automatically starts with a new untitled project, with one blank untitled file. 

If you previously saved the project with Project|Save Project As, then the closed project is added to the top 
of the Project|Open Project submenu. You can use that submenu to quickly reopen the project. When you 
open the project again, it will show up with the same set of open files as you had open when you closed the 
project. The only exception are outside files in managed projects. Since outside files arenõt part of the project, 
they arenõt remembered by it and arenõt reopened when you reopen the project. 

If you did not previously save the project, it will be closed without asking you whether you want to save it. If 
you want to work with the same set of files again, youõll have to reopen the files separately. 
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Project|Close All but Current 

Closes all projects and all the files in them, except for the current project, as if you used Project|Close Project 
on each of those projects. 
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4. Search Menu 

Search|Prepare to Search 

Use the Prepare to Search command in the Search menu to enter a search term that you can then use for 
searching or for searching and replacing. Its default keyboard shortcut is Ctrl+F. Exactly what the Prepare to 
Search command does depends on the state EditPad is in and on your preferences. 

EditPad provides two search interfaces. When you start EditPad the first time, the search toolbar is docked 
to the bottom of EditPadõs window. The search toolbar provides all of EditPadõs search and replace 
commands. It has two combo boxes for entering a short single-line search term and replacement text. You 
can show or hide the search toolbar by right-clicking on any toolbar or the main menu and selecting Search. 

 

If you use the Toggle Search Panel command, EditPad switches to the full search panel. This panel has two 
large multi-line edit controls for entering the search term and the replacement text. It also incorporates the 
search toolbar with all the search and replace commands, but without the two drop-down lists. 

 

If the full search panel is visible, the Prepare to Search item puts keyboard focus in the edit box for the search 
term. If the search panel is not visible but the search toolbar is visible, Prepare to Search puts keyboard focus 
in the combo box for the search term. If the search panel and search toolbar are invisible, Prepare to Search 
opens the full search panel and puts keyboard focus in the edit box for the search term. 

If the òuse the current word or the selected text as the default search textó preference is turned on, then the 
Prepare to Search command uses the selected text as the default search term, as long as the selection does not 
span multiple lines. If there is no selection, then the word under the cursor is used as the default search term. 
If there is no selection and no word under the cursor, then the last used search term stays in place. If the 
preference is turned on, the last used search term always stays in place. The Prepare to Search command 
always selects the search term. You can replace the search term directly by typing in a new one. 

If the òautomatically turn on óselection onlyò when multiple lines of text are selectedó preference is turned 
on, then the Prepare to Search command automatically turns on the Selection Only or Block search option 
when there is a selection that spans multiple lines. When the preference is off, the state of this option is 
unchanged. 
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Search|Toggle Search Panel 

EditPad provides two search interfaces. When used by itself, the search toolbar is docked to the bottom of 
EditPadõs window. The search toolbar provides all of EditPadõs search and replace commands. It has two 
combo boxes for entering a short single-line search term and replacement text. 

 

The full search panel has two large multi-line edit controls for entering the search term and the replacement 
text. It also incorporates the search toolbar with all the search and replace commands, but without the two 
drop-down lists. 

 

When you start EditPad for the first time, only the search toolbar is visible. You can switch to using the full 
search panel by selecting Toggle Search Panel in the Search menu. You can switch back to using the search 
toolbar only by using Toggle Search Panel again. 

When the search toolbar is visible but the full search panel is not, you can hide the search toolbar by right-
clicking on any toolbar or the main menu and selecting Search. When both the search toolbar and search 
panel are invisible, the Toggle Search Panel makes both visible as usual, but using Toggle Search Panel again 
will hide both the search toolbar and search panel again. If you want to bring back the search toolbar without 
the full search panel, right-click again on any toolbar or the main menu and select Search again. 

To summarize: EditPad has 3 modes for its search interface: toolbar and panel hidden, toolbar visible alone, 
panel with toolbar visible. The Toggle Search Panel command switches from one of the first 2 modes to the 
òpanel with toolbar visibleó mode, and back to whichever of the first 2 modes you were using. Right-clicking 
on a toolbar and selecting Search switches between the first two modes. 

Both the search and replace edit boxes on the search panel are full-blown multi-line edit controls, just like 
EditPadõs main editor. They provide syntax coloring for regular expressions and match placeholders. Press 
Shift+Enter on the keyboard to type in and search for or replace with a newline. To type in a tab, press 
Shift+Tab. To switch from search to replace and back, press Tab. 

If you right-click on the search or replace edit box, you will see a list of the last 16 search or replace texts you 
used. Click on one to use it again. 

Search|Find First 

After using Prepare to Search or pressing Ctrl+F and entering a search term, click the Find First button on 
the search toolbar or select the Find First item in the Search menu to find the first search match. If the 
òselection onlyó option is on, Find First starts searching from the start of the search range. If òall filesó is on, 
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Find First starts searching from the start of the first file in the current project. If òall projectsó is on, Find 
First starts searching from the start of the first file in the first project. If none of these three options are on, 
Find First starts searching from the start of the current file. 

If the search term can be found, EditPad will switch to the file it was found in, and select the matched text. If 
the search term cannot be found, nothing will happen, except that the Find First button will briefly flash its 
icon to indicate it failed. 

In EditPad Pro, the Find First button on the search toolbar has a drop-down menu. This drop-down menu 
has three items that you can use to find a specific search match, counting search matches from the start. The 
Find 10th item will find the 10th search match. It start searching from the beginning to find the first search 
match, and immediately continues to find the second, third etc. until it arrives at the 10th match. The 10th 
match will then become selected. If there are less than 10 search matches, nothing will happen, and the Find 
First button will briefly flash its icon to indicate the search failed. Similarly, the Find 100th item will skip the 
first 99 search matches and select match #100. 

The Find Nth item will ask you for the number of the match you want to find. If you enter 42, EditPad will 
skip the first 41 search matches, and highlight the 42nd. 

Search|Find Next 

After using Prepare to Search or pressing Ctrl+F and entering a search term, click the Next button on the 
search toolbar or select the Find Next item in the Search menu to find the next search match. If the edit box 
for entering the search term still has keyboard focus, you can also find the next search match by pressing 
Ctrl+F again or by pressing Enter. 

Find Next starts searching from the current position of the text cursor in the current file. If the òselection 
onlyó option is on, Find Next searches until the end of the search range. If òall filesó is on, Find Next 
searches until the end of the file and then continues at the start of the next file until a search match is found. 
If òall projectsó is on, and Find Next reaches the last file in the current project, Find Next will continue with 
the next project. 

If the search term can be found, EditPad will switch to the file it was found in, and select the matched text. If 
the search term cannot be found, nothing will happen, except that the Next button will briefly flash its icon 
to indicate it failed. 

In EditPad Pro, the Next button on the search toolbar has a drop-down menu. The first item in the drop-
down menu is Find in Next File. When you select this item, EditPad will start searching from the start of the 
next file. You can use Find in Next File even when the  òall filesó option is off. If the search term cannot be 
found in the next file, and one or more of the òall filesó, òall projectsó and òloop automaticallyó options are 
on, EditPad will continue the search just like the Find Next command itself. 

The drop-down menu also has three items that you can use to find a specific search match, counting search 
matches from the start. The Find 10th Next item will skip over the next 9 search matches and highlight the 
10th. The result is the same as if you had clicked the Next button 10 times. If there are no further 10 search 
matches, the result is slightly different. Find Next 10th will then not do anything, except flash the Next 
button to indicate failure. Similarly, the Find 100th Next item will skip the next 99 search matches and select 
match #100. 


























































































































































































































































































































































































































































































































































































































































































